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Your IT manager has asked you to find ways to help computer users be more productive
and provide support services to them without requiring you to purchase third-party tools
and software. You decide to brush up on the native applications in Windows 7, such

as Internet Explorer 9, Snipping Tool, Windows Media Player, and Windows Media
Center. To help remote users who run into problems with their software or who just
need quick tutorials, you'll begin using Windows Remote Assistance. Finally, you plan

to show frequent travelers how to use Remote Desktop Connection to access files from
their home or work computers.
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Understanding Windows Internet Explorer

Although Windows 7 usually ships with Internet Explorer 8, the most current Microsoft
Web browser as of this writing is Internet Explorer 9, which is also the version that the
98-349 exam focuses on. Microsoft made many improvements to Internet Explorer 9—the
Web surfing experience is now much easier, safer, and private than ever before.

Internet Explorer 9 is the latest Web browser from Microsoft. The browser is faster and less
cluttered than previous versions, and it includes several privacy, security, and interface features
that enhance the user browsing experience with a focus on usability and safety.

CERTIFICATION READY Microsoft introduced tabbed browsing in Internet Explorer 7 and has improved the feature
What are some of the in Internet Explorer 9. This feature allows you to keep all your favorite Web sites open
improved features of within one Internet Explorer window. The Internet Explorer 9 interface also includes a
Internet Explorer 97 large Back button, a consolidated menu, and a combined Address bar and search box (see
Figure 3-1).

The New Tab page (sce Figure 3-2) in Internet Explorer 9 appears when you click the New Tab
button or press Ctrl+T. This page initially provides some thumbnails of Web sites you might
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be interested in visiting. As you use Internet Explorer 9, the sites you visit most often appear
on this page, giving you one-click access to frequently visited sites. You can remove sites from
the New Tab page by right-clicking a site’s thumbnail and selecting Remove this page from the
shorteut menu.
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Figure 3-2 =
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InPrivate Browsing

The New Tab page also provides commands for reopening closed tabs and starting InPrivate
Browsing, which is explained later in this section.

Internet Explorer 9 introduces One Box, a feature that combines search functionality into the
Address bar. One Box saves you time by using AutoComplete to help you complete Uniform
Resource Locators (URLs), and allows you to enter search terms directly in the text box like
you would in a search engine. Relevant suggestions for your search appear in a drop-down list
(see Figure 3-3) that you can select or you can continue typing and then press Enter to see
results in the default search engine.
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Figure 3-3

Searching within One Box

Eog:9 |
Bing Suggestions
=-251
Popular 5earches
0E349
08349-07v
083497

£y

NS

. TTST.COTT IErOSOTT Smarts
Drop-down list appears Corporation: Softwar... Micros
when you begin typing a
search term

/Turn off suggestions (stop sending keystrokes to Bing)

K NOTE For privacy reasons, search suggestions are turned off by default. To enable search

suggestions, select Tirn on suggestions in the drop-down list.

Another new feature of Internet Explorer 9 is the Notification bar, which displays at the
bottom of the browser window. All notifications, such as blocked pop-up windows and error
messages, display in the Notification bar rather than in pop-up windows. You can click the
options in the Notification bar or ignore them, depending on your preference.

\
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Using Pinned Sites

Pinned sites makes it easy for users to get to frequently visited Web sites.

A pinned site is an Internet Explorer 9 Web site you “attach” to the Windows 7 taskbar. A
pinned site is simply a quick way to open a Web site, much like you open a program that’s
pinned to the taskbar. Pinned sites let you access Web sites without having to open and navi-
gate your Favorites list, or even open Internet Explorer first.

O PIN A WEB SITE TO THE WINDOWS 7 TASKBAR
GET READY. To pin a Web site to the Windows 7 taskbar, perform the following steps:

1. Launch Internet Explorer 9 and browse to any Web site.

2. Click the tab for the Web site and drag it to the taskbar (see Figure 3-4). You can also
click and drag the Web site’s thumbnail that appears on the New Tab page.
An icon for the pinned site also appears to the left of the Back button in Internet
Explorer 9. The site also shows up as a thumbnail on the taskbar (see Figure 3-5).
When you hover your mouse pointer over a pinned site, a preview appears if an Aero
theme is enabled. If the pinned site is for e-mail, such as Microsoft Hotmail, you
may see brief status messages such as the number of new e-mails that have arrived
since you last checked your account.
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Figure 3-4

Pinning a Web site to the
taskbar

Figure 3-5

A pinned site appears in
Internet Explorer 9 and on the
taskbar
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To pin additional Web pages to a pinned site so all pages open by clicking a single thumbnail,
perform the following steps:
1. Open the pinned Web site.
2. Open the site you want to add, and then click its tab.
3. Right-click the pinned Web site’s icon to the left of the Back button, and then click
Add as a home page (see Figure 3-6).

To unpin a site from the taskbar, right-click the pinned site’s icon and select Unpin this
program from taskbar.
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Figure 3-6

Adding a site as a home page
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To learn more about pinned sites, visit http://windows.microsoft.com/en-US/internet-explorer/products/ie-9/
features/pinned-sites
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Managing Security Features
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a lot of security and privacy features in Internet Explorer 9 to make Internet browsing a
safer experience.

Internet Explorer 9 includes many features that help you protect your computer and privacy
while surfing the Web. Some features have been around for a while, such as Pop-up Blocker,
while others have been introduced in Internet Explorer 9. With the millions of viruses,
worms, and other threats lurking on the Internet, it’s highly recommended that you, at mini-
mum, use the default Internet Explorer 9 security settings. You should even choose more
secure settings for your safety.

You can change a variety of options for safety and security and general default behaviors

in Internet Explorer 9 by clicking the Tools icon and then clicking Internet options. The
Internet Options dialog box displays; this dialog box features tabs that allow you to customize
your Web browsing experience. Let’s look at the Security tab and the Privacy tab.

The Security tab (see Figure 3-7) is where you select a security zone, which is a group of
security settings for a type of site: Internet, Local intranet, Trusted sites, or Restricted sites.
For each zone, you can move the slider up or down to select higher or lower security settings.
You can also click the Custom level button to customize individual security settings, such as
scripts, ActiveX controls, NET Framework, and more.

The Privacy tab (see Figure 3-8) also uses a slider to select levels of privacy controls, mainly
for blocking or allowing cookies.

The Pop-up Blocker check box (selected by default) automatically prevents pop-up windows
from appearing. Most pop-up windows are created by advertisers and appear when you first
open a Web site. However, their content can be malicious, so the Pop-up Blocker feature
prevents them from opening.

© Danita Delimont/Gallo Images/Getty Images
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In Internet terms, “malicious” refers to viruses, worms, spyware, and other content that
TAKE NOTE can harm your computer. Many of the security features in Internet Explorer 9 prevent
malicious content from invading your computer.

Many other Internet Explorer 9 security controls are accessible from the Tools menu on the
menu bar or the Safety menu on the command bar (if enabled). The first menu item is Delete
browsing history, which allows you to erase Temporary Internet files, cookies, history, and
many other “trails” of information all from a single dialog box (see Figure 3-9).

When you visit Web sites, your browser might store cookies (small text files that Web sites save
to a computer’s hard disk that contain information about the user and his or her browsing pref-
erences), temporary Internet files, user names, passwords, and other data for your convenience.
When you visit the sites again in the future, this information is already available to your
browser so you don’t have to reenter data. It’s also meant to personalize the visit by remember-
ing your information. However, the information can pose a security risk, especially if you share
your computer with others, whether at home or work, or if you use a shared computer at the
library, for example. InPrivate Browsing helps prevent personal information and browsing
history from being stored by Internet Explorer 9. When you use InPrivate Browsing, a new tab
appears in which you browse the Internet (see Figure 3-10). When you're finished and close
the browser window, the session ends and any cookies or temporary files that were used during
the session are cleared from your browsing history. A network administrator, however, can view
Internet traffic that’s generated with InPrivate Browsing.
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The Privacy tab
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Some Web sites store a lot of information about your browsing sessions in cookies. For
example, if you visit a shopping site, one or more cookies on your PC might include
information about specific items you viewed or purchased. Advertising networks use
cookies to “follow” you on the Web and display targeted advertising. After visiting a

m social networking site like Facebook, for example, a cookie might contain information

related to what you typed on a friend’s wall. If; for example, you mentioned you bought

a great pair of Nike running shoes, the right side of your Facebook page might display
an ad from a sporting goods retailer that sells Nike running shoes or you might even
see an ad from Nike.com.

Tracking Protection helps you control which Web sites can track your online browsing
activity and receive that information. This is accomplished with a Tracking Protection

list. You can create your own Tracking Protection lists or download lists from the Internet

Explorer Gallery Tracking Protection Lists Web site at http://iegallery.com/en/
trackingprotectionlists/.

ActiveX Filtering blocks ActiveX controls, which are created for interactivity on the
Web and commonly used on sites that display animations or offer multimedia such as

S ECRIRESALE
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videos. ActiveX is meant to enhance the user experience on the Web, but it can slow your
computer. In addition, some attackers use ActiveX to push harmful content to unsuspecting
users. ActiveX Filtering allows you to block ActiveX completely, or to trust certain sites and

block all others.
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Figure 3-9
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Other important security features include:

L) [

e SmartScreen Filter: The SmartScreen Filter detects threats on Web sites, such as

phishing attacks and malware downloads, and prevents them from running. When

Internet Explorer 9 detects a malicious Web site, it blocks the entire site from being
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accessed. It can also block malicious portions of legitimate Web sites, allowing the rest of
the site to display as normal. SmartScreen Filter is enabled by default.

* Cross-site scripting (XSS) filter: A cross-site scripting attack occurs when you visit
a compromised Web site that runs a script that installs a keylogger program on your
computer. The installation occurs without your knowledge. After that, the keylogger
records your keystrokes, including when you enter user names and passwords into
other sites. The information is usually sent to a third party, who may access your
accounts. The cross-site scripting (XSS) filter prevents the keylogger script from
running.

® Domain highlighting: Some Web sites use deceptive Web addresses, making you think
you're visiting a legitimate site when you're actually on a phishing site or another danger-
ous site. Domain highlighting shows you the true Web address of any Web site you visit
by highlighting the domain in the Address bar.

Many Internet Explorer 9 security features are available in various forms in third-party
Internet security suites.

To learn more about ActiveX filtering, visit http://windows.microsoft.com/en-US/internet-explorer/products/ie-9/
features/activex-filtering. Information on the cross-site scripting filter is available at http://windows.microsoft.
com/en-US/internet-explorer/products/ie-9/features/cross-site-scripting-filter. Need extra help understanding
InPrivate Browsing? Go to http://windows.microsoft.com/en-US/internet-explorer/products/ie-9/features/
in-private. Finally, you can learn more about SmartScreen Filter at http://windows.microsoft.com/en-US/internet-
explorer/products/ie-9/features/smartscreen-filter
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GET READY. To configure security features in Internet Explorer 9, perform the following
steps:

1. Launch Internet Explorer 9.

2. To access Pop-up Blocker settings, click the Tools icon in the upper-right corner of
the Internet Explorer 9 window, and then click Internet options.

3. In the Internet Options dialog box, click the Privacy tab, and then click the Pop-up
Blocker Settings button. To allow pop-ups from a particular trusted Web site, such
as your bank, type the URL in the Address of website to allow text box and then
click Add.

4. Click Close to close the dialog box.

5. To enable ActiveX Filtering, click the Tools icon in Internet Explorer 9, point to
Safety, and then click ActiveX Filtering. A check mark appears next to ActiveX
Filtering to indicate the feature is enabled (see Figure 3-11).

6. To use Tracking Protection, click the Tools icon, point to Safety, and then click
Tracking protection. In the Manage Add-ons dialog box (see Figure 3-12), click a
Tracking Protection list (if available), and then click Enable.

7. To download a Tracking Protection list, click the Get a Tracking Protection List
online link and then follow the prompts.

8. To use InPrivate Browsing, click the Tools menu, point to Safety, and then click
InPrivate Browsing. A new browser session opens, which keeps your browsing actions
private.

9. When you're finished, just close Internet Explorer to end the InPrivate Browsing
session.
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Figure 3-11
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Some security features, such as Tracking Protection, might require you to close Internet
Explorer 9 and then reopen it to see the features in action.

Introducing Accessory Programs

Microsoft provides a wealth of free programs and utilities in Windows to help you be more
¥ productive, creative, and efficient. The Accessories folder in the All Programs list is your
starting point for lots of handy tools.

Windows 7 comes bundled with many useful accessory programs, such as Calculator,
Notepad, Paint, Snipping Tool, Windows Media Player, WordPad, and many more. The
programs allow you to be productive in Windows without purchasing third-party programs.
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To access these programs, click Start > All Programs > Accessories. Table 3-1 lists the pro-
grams in the Windows 7 Accessories folder. Not all programs are available in every edition of

Windows 7.

Window 7 Accessory

Programs

Calculator

Command Prompt

Connect to a Projector
Connect to a Network
Projector

Math Input Panel

Notepad
Paint

Remote Desktop
Connection

PROGRAM DESCRIPTION

Performs basic mathematical functions such as addition, subtraction,
multiplication, division. Also includes scientific, programmer, and
statistics functions, along with unit conversions, date calculations,
and worksheets to determine mortgage payments, vehicle lease
payments, and fuel economy.

Opens a window in which you run MS-DOS and other computer
commands.

Allows you to expand your screen to use another monitor or
external projector.

Allows you to write and correct free-hand math equations using your
mouse or other pointing device.

Serves as a simple text editor.
Allows you to perform basic image editing.

Connects two computers over a network or the Internet, allowing
one computer to.see.and use.the other computer’s desktop. Remote
Desﬁtop Connection is covered later in this lesson.
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Snipping Tool
Sound Recorder
Sticky Notes

Sync Center

Windows Explorer

Windows Mobility Center

WordPad

Ease of Access

require elevated or administrative privileges; to run these commands,
use the Run as administrator command.

Allows you to capture, annotate, and save screen shots. Snipping
Tool is covered later in this lesson.

Allows you to record sound from different audio devices, such as a
microphone that's plugged into the sound card on your computer.

Allows you to keep notes on the desktop to help you remember
important items. Available in different colors.

Allows you to sync any folder in your computer with a folder on an
external drive connected to your computers or a network drive. Sync
Center is covered later in this lesson.

Allows you to access files and folders on your computer, copy and
move items, search for items, and more. This graphical file
management system is built into many versions of Windows.

Allows you to control many different computer settings, such as
screen brightness, volume, power/battery, WiFi, Bluetooth, sound,
and so on. Windows Mobility Center is covered later in this lesson.

Serves as a word processor, with many more features than Notepad.

Allows you to open the Ease of Access Center to configure
accessibility options, and gives you access to the speech recognition
feature. See Lesson 2.

(continued)
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Table 3-1
System Tools Gives you access to Control Panel, Disk Cleanup, Disk
Defragmenter, Resource Monitor, System Restore, and much more.
Tablet PC Gives you access to tools to use a tablet PC's input device.
Windows PowerShell Opens a command window useful for IT professionals. Windows

PowerShell is covered later in this lesson.

This lesson covers Snipping Tool, Sync Center, Windows Mobility Center, and Windows
PowerShell in detail because they're listed as measureable skills for the 98-349 exam.

Using the Snipping Tool

3 Home and business users alike need to capture screen shots occasionally for many different
reasons. Windows 7 includes the Snipping Tool, an easy-to-use screen capture program
with a few editing features.

A screen shot, also referred to as a snip or screen grab, is a snapshot of whatever is displayed
on the computer screen. You might take a screen shot of an error message to help trouble-
shoot a computer problem, you might capture screen shots of a process in a program to create

LICENSEDERERODUCT NOTFORRESALE

The Snipping Tool (see Figure 3-13) is an accessory program that comes with Windows 7
that allows you to take screen shots, annotate them, and save them. When using Snipping
Tool, you can capture the entire screen, a window, a rectangular portion of the screen, or
a free-form image. The free-form capture allows you to use your mouse pointer or other

CERTIFICATION READY
What is the Snipping Tool

used for?

pointing device to draw around a non-rectangular object on the screen.

Figure 3-13
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c% Snipping Teol —e
The Snipping Tool window

%ﬂew * (2| Cancel -;I;"._‘. Options
-

Select a snip type from the menu 1@1
or click the New button,

You can save images in GIE JPG, PNG, or HTML format, then use Snipping Tool to add
frechand annotations, highlight or erase part of the image, or send it to a recipient via e-mail.
If you select the HTML format, Snipping Tool saves the screen shot as a Web archive file in
MHT format, which you can open in a Web browser such as Internet Explorer.

The Snipping Tool is available in Windows 7 Home Premium, Professional, Ultimate,

and Enterprise editions.
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O USE THE SNIPPING TOOL TO CAPTURE A SCREEN SHOT

GET READY. To capture a screen shot with the Snipping Tool and save it as a graphics file,
perform the following steps:

1.

2.
3.

Open or display a file, program, window, Web page, or anything that contains an
object or picture you want to capture in a screen shot.

Click Start > All Programs > Accessories > Snipping Tool.

Click the New drop-down menu and choose Free-form Snip, Rectangular Snip,
Window Snip, or Full-screen Snip (see Figure 3-14). The default is Rectangular Snip,
which is used in this example.

Selecting the type of screen
shot to capture

-
C_% Snipping Tool

]

R

o| Cancel e Options

bt L

L=
o
| —

Free-form Snip

Rectangular Snip

Window Snip

Full-screen Snip

. A white overlay appears on your screen. Click and drag the mouse pointer over the

area you want to capture (see Figure 3-15). An editing window appears, displaying
the captured image.
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Figure 3-15
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To save the image, click the Save Snip icon on the toolbar, which looks like a floppy
diskette.

In the Save As dialog box, navigate to the location where you want to save the
screen shot. In the File name text box, type a descriptive name for the file.

Click the Save as type drop-down menu and select GIF, JPG, or PNG.
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TAKE NOTE

Figure 3-16
Annotating an image

LICENS

GIF files support 256 colors and are used primarily for Web sites. JPG is the most
common picture file format, and it supports over 16 million colors. PNG files are an
improvement to the GIF format and support “lossless compression,” which means you
can enlarge a PNG file to a certain extent without losing clarity and crispness.

8. Click Save. The screen capture is saved as a graphics file.

USE THE SNIPPING TOOL TO ANNOTATE AN IMAGE

GET READY. To annotate an image using the Snipping Tool, perform the following steps:

1. In the Snipping Tool editing window, click the down arrow to the right of the pen
button on the toolbar. Select a pen color from the list.

2. Write or draw on the image (see Figure 3-16).

-
@ Snipping Teol

 File Edit Tools Help

Qi ld & 8 -

D PRO UQTN T

]

é’,‘ &
14

Annotation drawn with pen tool

Ll

3. Click the Save Snip icon to save the annotated image under the current file name or
a new file name.
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Remember, you can open an image saved with Snipping Tool in any graphics program
(including Paint) to make detailed edits.

For more information about the Snipping Tool, visit http://windows.microsoft.com/en-US/windows7/products/
features/snipping-tool

Playing Back and Recording to Media

Windows Media Player and Windows Media Center provide a wealth of media playback,

¥ ripping, and recording options. No longer relegated only to home use, both programs
JTHE BOTTOM LINE  can be used in the work place for highly appealing presentations, training, and lobby
entertainment.

Digital media is popular for both home and business users of Windows 7. Although many
media software packages are available on the market, you should check out the latest versions
of Windows Media Player and Windows Media Center to see if third-party tools are even
needed. Both programs come bundled with most Windows 7, so home and business users
have access to these full-featured programs without spending additional money.

LICENSED dsistikbwi hétia bajet O - OR RESALE

If you need to simply play back almost any type of multimedia file, Windows Media
Player should be the program you use. It’s built into Windows 7 (so it’s free), and its
media burning and ripping features, along with the ability to stream multimedia to other
networked computers, makes it a great choice at home and work.

Windows Media Player 12 is a program that allows you to play back music and video files
and view photos. Files stored in your Music, Pictures, Videos, and Recorded TV libraries
appear in the Windows Media Player file list by default. If you're connected to a network,

CERTIFICATION READY
What is the name of

the main window in

Windows Media Plaver? you can stream digital media files—audio, video, or photos—for playback or viewing from
1.3 another computer or a server that hosts Windows media files. The main window in Windows
Media Player is called the Player Library (see Figure 3-17).

Whether playing digital files on your computer, or from a CD or DVD, Windows Media
. . Player includes common playback controls, such as Play, Shuffle, Repeat, Stop, Next,
Windows Media ) . . . .
Plaver 12 b Previous, and a volume slider. You can switch to a smaller window, referred to as Now Playing
3 é}II)CIAA CS u};\p/ocrlt_snt) ¢ mode, by clicking the Switch to Now Playing button in the lower-right corner. The Now
> g ’ Playing mode window appears (see Figure 3-18). To return to your library, click the Swizch ro

MIRBE=, WM, Library button.
and WMA audio and
video formats. It also With Windows Media Player, you can do the following as well:

supports most AVI,
DivX, MOV, and
Xvid files.

* Create playlists: Organize your music files into playlists, which are simply lists of music
composed of songs from different albums, and may even be located on different areas of
your computer or attached devices. Whatever appears in the library may be included in a
playlist.
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Figure 3-17

Windows Media Player main
window—the Player Library

Figure 3-18

Windows Media Player Now
Playing mode
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TAKE NOTE

Microsoft has made
Windows Media
Player available in
most editions of
Windows 7: Starter,
Home Premium,
Professional, Ultimate,
and Enterprise.
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* Rip music from CDs to your computer: Insert a CD and, when a list of its tracks
appears in the Windows Media Player window, click the Rip CD button. Windows
Media Player rips the tracks on the CD to your Music library.

* Burn CDs: If you have a recordable optical drive on your computer, you can use
Windows Media Player to burn a collection of your favorite songs to a CD.

* Create slide shows: Use Windows Media Player to create slide shows with playback con-
trols in just a few clicks.

* Share media across a network: You can use the Play ro command to share multimedia
files across a network with a homegroup (a personal network, usually set up at home) or
across the Internet.

If you pin Windows Media Player 12 to the Windows 7 taskbar, you can take advantage of
Jump Lists for previously accessed files. The Jump List also includes playback controls at the
bottom of the Jump List window to play music, a video, or view photos without having to
open Windows Media Player first.

For more information about Windows Media Player in Windows 7, visit http://windows.microsoft.com/en-US/
windows7/products/features/windows-media-player-12 and http://windows.microsoft.com/en-US/windows7/
Getting-started-with-Windows-Media-Player
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O PLAY BACK MEDIA FILES

LICENSED

Figure 3-19 -

Playback controls appear in the
video viewing window when
you hover your mouse pointer
over the window

GET READY. To listen to music files, watch videos, or view photos in Windows Media Player,
perform the steps in this section.

To listen to music files in Windows Media player, perform the following steps:

1.

Open Windows Media Player by clicking Start, selecting All Programs, and then
selecting Windows Media Player near the top of the programs list. You can also click
its icon in the taskbar if it appears there.

Click the Music library in the navigation pane, click the file you want to hear in the
file list, and click the Play button along the bottom of the window.

Another option is to click the Play tab in the upper-right corner of the Windows
Media Player window, drag the songs you want to hear to the Play tab, and then click
the Play button.

. After the file has finished playing, Windows Media Player automatically plays the next

file in the list.

To watch a video in Windows Media Player, perform the following steps:

1.

Click the Videos library in the navigation pane, and then double-click the file you
want to view in the file list. Windows Media Player launches a special viewing window
and plays back the video.

. Place your mouse pointer over the window to display playback controls (see

Figure 3-19).

PRODUCT NOT-FORIRESALE

ol

Playback controls
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To view photos in Windows Media Player, perform the following steps:
1. Click the Pictures library in the navigation pane. Thumbnails of the photos in your
Pictures library appear.

2. To view all of the photos as a slide show, click the Play button. Windows starts the
slide show in its own window (see Figure 3-20).

Figure 3-20 o =S

A slide show in Windows
Media Player

rtesy of Marion Post Wolcott, Farm Security Administration/Office of

formation

el
War In

LICENSEE

To stop any playback feature, click the Stop button in the playback controls, and then click
Go To Library.

© CREATE A PLAYLIST

GET READY. To create a playlist of music, perform the following steps:

1. In Windows Media Player, in the Player Library, click the Create playlist button on
the toolbar.
2. Type a name for the new playlist that appears in the Navigation pane (see Figure 3-21).

3. Drag and drop songs from the file list to the new playlist in the Navigation pane.

An auto playlist gives you more control and options. To create an autoplaylist, click the down
arrow on the Create playlist button, select Create auto playlist, and follow the prompts.

© BURN A MUsIC cD
GET READY. To burn a music CD, perform the following steps:

1. Insert a blank CD or DVD into your computer’s recordable media drive.

2. In Windows Media Player, in the Player Library, click the Music library to display the
file list.

3. Click the Burn tab.

4. Drag individual songs, playlists, or entire albums to the burn list on the right (see
Figure 3-22).
5. Click Start burn.
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Figure 3-21

Creating a playlist in Windows
Media Player

Figure 3-22
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Dragging a song
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The CD ejects when the burning process completes. The burn process works similarly for
other types of media files.
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O PREPARE YOUR COMPUTER TO STREAM MEDIA FILES

Figure 3-23

Configuring streaming media
options

LICENSED PROE

GET READY. To stream media from your home computer, perform the following steps:
1. Ensure your computer is connected to your local network and that you are connected
to a homegroup. For information on homegroups, see Lesson 6.

2. In Windows Media Player, in the Player Library, click Stream on the menu bar and
then select Turn on media streaming with HomeGroup.

3. On the Media streaming options page, click Turn on media streaming. If you're
prompted for an administrator password or confirmation, type the password or provide
confirmation and then click OK.

4. In the Network and Sharing Center window, click Advanced sharing settings (or click
Choose homegroup and sharing options).

Click Choose media streaming options.
6. Type a name for your media library in the text box at the top (see Figure 3-23).

o

g —— E; ™y

@uv@ <« Metwork and Sharing Center » Media streaming options - | 3 | | Search Control Panel pe |

Choose media streaming options for computers and devices

m @] Name your media library: ~ Family o——— Enter name for media Iihrary
L) Choose default settings...

Choose All networks
Showde\riceson:or Local networks [ Allow Al | [(BlockAll
UeT NG roReR
55 Qaefl O It sktings.

<[‘;:)::' HPdv7 Allowed -

=~/ Allowed @ccess using default settings.

»

|
[t=

SAL

N U

All devices are allowed to access your shared media. |

Choose homegroup and sharing options Choose Allowed or
Choose power options Blocked for each device

Tell me more about media streaming
Read the privacy statement online

ok | [ Cancel

7. Choose to show devices on the local network or on all networks.

8. For each device, choose Allowed or Blocked to control whether others can see files
on those devices.

9. Click OK and then close the Network and Sharing Center window.
To stream media files over the Internet, perform the following steps:
1. In Windows Media Player, in the Player Library, click Stream and then click Allow
Internet access to my home media.
2. In the Internet Home Media Access dialog box, click Link an online ID.

3. Follow the prompts to link your user account with an online ID, such as your Windows
Live ID. When you return to the Internet Home Media Access dialog box, click Allow
Internet access to my home media again (see Figure 3-24). Click Yes in the dialog
box that appears, and then click OK.
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" ) - -
Figure 3-24 Internet Home Media Access M
The Internet Home Media

Access dialog box

Do you want to allow Internet access to home media?

Internet access to home media lets you stream music, pictures, and videos from a home
computer to a computer cutside your home, If this computer is at home, it can send
media over the Internet. If this computer is away from home, it can receive media from a
home computer.

Please note that corporate networks often block home media streaming.

Tell me more about accessing home media over the Internet

& Allow Internet access to home media

2 Do not allow Internet access to home media

Cancel

“ @I Allowing Internet access to home media will prevent this computer from sleeping.

The Play To feature in Windows Media Player allows you to select multimedia you would
like to play on a connected device, such as a stereo system at home. Just select the media you
want to stream in Windows Media Player, click the Play tab, click the Play ro button near the
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ume and other settings.

Using Windows Media Center

Windows Media Center is a cut above Windows Media Player, incorporating many
of the same types of features but with digital video recorder functionality and built-in
access to online entertainment content.

Windows Media Center (sce Figure 3-25) is a multi-faceted program that provides a
complete entertainment system for your computer. Similar to Windows Media Player, you
use Windows Media Center to play music, create playlists, watch videos, play recorded
TV programs, and display pictures and slide shows. However, Media Center offers much
more. For example, you can watch, pause, and record HDTV, watch live TV and online
programming, and listen to radio stations.

CERTIFICATION READY Watching TV programming requires a TV tuner and a subscription to a cable service or a
What Windows 7 similar service. You don't need a digital video recorder (DVR)—your computer acts like a
program is used to play DVR, enabling you to record shows and even schedule shows in advance. If you don’t have
recorded TV programs? a TV tuner but do have Internet access, you can still use Internet TV in the latest version of
Windows Media Center. Internet TV is a service that allows you to watch some TV shows,
movies, and clips streamed from the Internet.

Windows Media Center supports the same audio and video formats as Windows Media
Player: 3GP, AAC, AVCHD, MPEG-4, WMV, and WMA, and most AVI, DivX, MOV, and
Xvid files.
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Figure 3-25 (€ Windows Media Center BN

The Windows Media Center
main window

-

settings

You can also share media over a network from Windows Media Center with the use of a
Windows Media Center Extender. You can buy an actual Extender device or use an Xbox
360 as an Extender. Each device you want to stream media to, such as an HDTYV, needs
an Extender. You can stream to uéto five Extenders from a si(nsle computer running
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© PLAY BACK OR VIEW MULTIMEDIA

GET READY. To use Windows Media Center for multimedia playback and viewing, perform
the following steps:

1. Click the Start > All Programs > Windows Media Center.

2. To view photos or videos, click Pictures + Videos, and then click Picture Library or
Video Library. Just double-click any pictures or videos you want to view.

3. Click the green Windows Media Center button in the upper-left corner of the Windows
Media Center to return to the main menu.

4. To listen to music, click Music Library. Select music you want to listen to, and then
click Add to now playing.

Use the playback controls at the bottom of the window to stop, pause, play, rewind, and for-
ward the multimedia file that’s playing.

© CONFIGURE SETTINGS
GET READY. To configure settings in Windows Media Center, perform the following steps:

1. In the Windows Media Center main window, hover your mouse pointer over the last
menu item at the bottom. A down arrow displays. Scroll down to the Tasks menu and
click Settings. The Settings window displays (see Figure 3-26).
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Figure 3-26

The Windows Media Center
Settings window

Figure 3-27

Adding media to Windows
Media Center

General

™V

Pictures

Music

DVD

Start Menu and Extras
Extender

Media Libraries

:Elg

To add an Extender:

5. Choose On this computer or On another computer and then click Next.

. Click Extender, click add extender, and then follow the prompts.

To add libraries of content to Windows Media Center, return to the Settings window
and then perform the following steps:

Return to the Settings window and click Media Libraries.

LICENSED PROEIE TNOTFORRESArE?

4. Click Add folders to the library and click Next.

6. Select the folders to add to the library (see Figure 3-27) and then click Next.

-
) Windows

Media Center

Media Library Windows Media Cente

Select folders that contain music

+ Dropbox-kimdros
+ Favorites

+ Links

+ My Music including sub-folders

My Pictures

200f 28 AV

Cancel
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7. Select Yes, use these locations and then click Finish. Windows Media Center adds
the content of the folders to your library.

There are many more settings to be familiar with in Windows Media Center. Take some time
to browse all of the options in the Settings window.

To get details about Windows Media Center, visit http://windows.microsoft.com/en-US/windows/products/
windows-media-center

Understanding Sync Center

¥ If you need to frequently switch between network folders and the files on your laptop hard
JIHEBOTTOMLINE  drive, use Sync Center to ensure that you always have the latest files.

Sync Center (see Figure 3-28) is a feature in Windows 7 that allows you to sync files between
your computer and a network location or with some mobile devices. Syncing allows you to
keep two or more versions of the same file, stored on your computer and on a network folder,

SO [ 1 b e b ot miN e e ORI ESALE

After syncing is complete, you can access network files without being connected to the

CERTIFICATION READY
What Windows 7 feature
allows you to sync files

resource. These files are referred to as offline files. You can also use Sync Center to check
the results of a recent sync to ensure the files were synced successfully, or to re-sync if errors

CERTIFICATION READY
occurred.

What term best describes
the type of files you To get started with Sync Center, you must first set up a sync partnership with the network
can access without or external drive you want to use. Then, anytime you want to ensure your files are synced,
right-click the network drive and select Always available offline. Once your files are done
syncing, a symbol appears next to the network drive so you can see at a glance that the files
are synchronized.

being connected to the
resource from which you
nchronized?

The Sync Center allows you to schedule synchronization, resolve errors that occurred during
synchronization, change the amount of disk space allocated to offline files, and encrypt your
offline files for security.

Although you can use Sync Center to sync a mobile device with your computer, Sync
TAKE NOTE Center doesn’t work with all devices. Instead, try Device Stage in Windows 7 or use the

sync software provided by the mobile device manufacturer.

For more information about Sync Center, visit http://windows.microsoft.com/en-US/windows7/What-is-Sync-
Center
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Figure 3-28 (=] @ ]

The SynC Center main window ®v|® + Control Panel » All Control PanelItems » Sync Center » - | 4,.| | Search Sync Center o |

Control Panel Home . . «
Keep your information in sync

* View sync partnerships View recent sync activity, sync now, or change your sync settings.
View sync conflicts

View sync results @

Set up new sync partnerships Unspecified (3)

Manage offline files ﬁ ; Conflicts
6 ; Sync Results
é ; Sync Setup

O SET UP A SYNCHRONIZATION PARTNERSHIP
GET READY. To set up a synchronization partnership, perform the following steps:

1. Open Sync Center by clicking Start > Control Panel > Sync Center. (Alternately,
click Start, and in the Search programs and files search box, type sync. In the
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box displays (see Figure 3-29).

Figure 3-29 [ |® Offline Files N )
The Offline Files dialog box 4
General

@ LUse offline files to keep copies on your computer of files stored
l on the network. This allows you to work with them even when
you are not connected or & server is unavailable.

[ ) Enable offine files

Offline Files is currently disabled.

Open Sync Center

lUse Sync Center if you want to sync your offline files now or chedk
for sync conflicts,

View your offine files

How do offline files work?

oc ) [Lcanedl ] [ 400y |
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3. Click Enable offline files, and then click OK. If you're prompted for an administrator
password or confirmation, type the password or provide confirmation.

4.. Close any open windows, shut down all programs, and then restart your computer.

5. Return to Sync Center and, in the left pane, click Set up new sync partnerships. The
Sync Setup screen displays (see Figure 3-30).

Figure 3-30 [ (=[G e

The Sync Setup screen

=
& () =[® <« syncCenter » syncsetup - | 43 || search Syme setup = 2

Control Panel Home .
Set up new sync partnerships

View sync partnerships Before you can sync with anything, you need to set up a sync partnership for it. If the
View sync conflicts itern you want to sync with is not listed here, your computer might not be able to

detect it or it might be incompatible with Sync Center,
View sync results

® Set up new sync partnerships @
Manage offline files
Folders (1) ~
— oy Offline Files Offline Files allows you to access network files
} MNetwork files available offline while warking offline, To set up Offline Files
Folders open a network folder, right click on a file or f...

6. Click the name of the drive in the list of available sync partnerships.
7. 0n the toolbar, click Set up.
8. Select the settings and schedule to determine how and when you want to sync your
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©' SYNCHRONIZE FILES

GET READY. To sync files on your computer with a network location, perform the following steps:

1. Click Start > Computer.
2. Browse to the drive or folder that contains the files you want to keep synchronized.

3. Right-click the name of the drive or folder, and then click Always available offline
(see Figure 3-31).

Figure 3-31

.. . £ ext-storage
Synchronizing files B chare ¢ | Share
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Copy

Create shortcut

Properties
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Once the synchronization process is complete, a symbol displays next to the network drive or
folder indicating that the files are synchronized.

Using Windows Mobility Center

TAKE NOTE

Figure 3-32
The Windows Mobility Center

LICENSED

Rather than using different tools to adjust your laptop’s screen brightness, wireless settings,
and more, just open the Windows Mobility Center, which displays groups of settings all in
one interface.

Windows Mobility Center is a control panel of sorts that gives you access to several laptop
settings, from volume to screen brightness to power options to WiFi and Bluetooth settings—
all in one place. Although the settings can be accessed from various icons and commands
within Windows, you can make adjustments from a single window in Windows Mobility
Center. Figure 3-32 shows the Windows Mobility Center window.

Windows Mobility Center is included on laptops running the Windows 7 Home
Premium, Professional, Ultimate, and Enterprise editions. Presentation settings, however,
are not available in Windows 7 Home Premium.

i ™y
@ Windews Mobility Center = | =
PRODUGT NOT.BORRESALE
Y — u I e | High perfu:urmance_ - l Turn wireless off l
Brightness | Velume Battery Status | Wireless Metwork
l Mo display I Mo sync I
&~ connected ' partnerships |
[ Connect display ] [ Sync settings ]
External Display . Sync Center

m Customized by Hewlett-Packard

EnwEn
E Protection

=i Enabled

ﬁga Integrated

Wireless Devices

- Choose Action - - [ Disable Protection

HP Wireless Assistant

Hard Drive Protection

Windows Mobility Center displays settings in boxes, or tiles. The tiles that are displayed
depend on your hardware and laptop manufacturer. In addition, a setting that is turned off or
disabled might not display, or display with a red X, such as if you turn off your WiFi antenna
by pressing the F key.
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Table 3-2 describes common Windows Mobility Center settings. Not all settings are available
on all laptops, so a few settings in the table are not displayed in Figure 3-32.

CERTIFICATION READY
Which settings can be

adjusted by using the
Mobility Center?

Table 3-2
Center Settings

Brightness Allows you to adjust the brightness of your laptop display. Move
the slider to the left to decrease brightness, and to the right to
increase brightness. Display brightness is related to the power
plan for your laptop; those settings are adjusted in the Battery
Status tile.

Volume Allows you to increase or decrease speaker volume, or check the
Mute check box to temporarily disable audio.

Battery Status Allows you to see how much battery charge remains and adjust the
power plan for your laptop. Power plans vary but offer two at a
minimum: one for running on battery power and another for running
on AC power.

Wireless Network Allows you to turn your wireless network adapter on or off and see
the status of your wireless network connection.

Screen Rotation For tablet PCs, this feature allows you to change the orientation of
your screen (portrait or landscape).

S EFRER OD e F I e ()RS Al

Sync Center Allows you to access settings to sync files with a network location,
or with a mobile’device. Sync Center is covered in more detail in
this lesson.

Presentation Settings Provides you with access to settings for connecting your laptop to a

projector for presentations.

For more information about settings in Windows Mobility Center, visit http://windows.microsoft.com/en-US/
windows7/products/features/windows-mobility-center

© CHANGE MOBILITY CENTER SETTINGS
GET READY. To adjust settings in Windows Mobility Center, perform the following steps:

1. Open Windows Mobility Center by clicking the Start button, typing mobility in the
Search programs and files search box, and then selecting Windows Mobility Center
from the results list.

2. Adjust the screen brightness by moving the Brightness slider left or right.

3. Click the Battery Status drop-down list (see Figure 3-33) and then select another
power plan, such as Power saver. Notice how the screen brightness changes again.

4.. Click the drop-down list again and select the original power plan.
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Figure 3-33
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Understanding Remote Desktop Services

CERTIFICATION READY
What term best describes
the Windows 7 technology
that allows a computer to
connect to a remote server
and then run applications

from that server?
2.4

The Remote Desktop
Services server must
run Windows Server
2008 R2, Windows
Server 2008, Windows
Server 2003, or
Windows 2000 Server.

Remote Desktop Services, formerly known as Terminal Services, enables computers to act
like mainframe terminals. The processing required to run applications and even use the
deskrtop is performed by the server rather than the client computer.

Windows 7 Remote Desktop Services is the technology that allows a computer (the client)
to connect to a remote server (also called a host computer) and run applications from the
server. Although the client computer may be running Windows 7, it doesn’t run the actual
application—the server handles all processing. This is the opposite of a typical Windows 7
computer with applications such as Microsoft Office installed on the hard disk. Remote
Desktop Services can also provide a virtual user desktop for remote users. When a user
accesses the server, the user is provided a virtual desktop interface that looks and responds
similarly to the client computer’s actual desktop.

A major benefit of Remote Desktop Services is that administrators can manage user desketops
and applications from a central place—at the server—rather than at the physical client computer.

A few of the services provided by Remote Desktop Services include the following:

* RemoteApp: Enables a remote user to log on to a Remote Desktop Services server via a
Web browser and run a single application.

* Remote Desktop Web Access: Enables a remote user to log on and run programs and
virtual deskeops. This feature lets users create a RemoteApp and Desktop Connection
using the Start menu on a computer running Windows 7 or via a Web browser.
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CERTIFICATION READY
Which Windows 7 feature
allows you to set up a
computer for remote

access and then connect to
that computer regardless
of where you might be
located?

CERTIFICATION READY
What does Remote
Desktop Connection

allow you to do?
2.4

Remote Desktop
comes with all
editions of Windows 7;
however, you can
only connect to
computers running
the Professional,
Ultimate, or
Enterprise editions.

In a Remote Desktop Services environment, a network administrator must first set up resourc-
es for a remote user to connect to. This is referred to as “publishing the resources.” The admin-
istrator must also send the user a setup file or Web address. The user either runs the setup file
or enters the Web address in a Web browser to make the connection to the server. Once a user
accesses the remote server, the resources will be available in a folder on the user’s computer.

CONNECT TO A SERVER USING REMOTE DESKTOP WEB ACCESS

GET READY. To connect to a remote server using Remote Desktop Web Access in a Web
browser, perform the following steps:

1. In a Web browser, type the Web address provided by the network administrator. The
Web address is in the https://computer name/rdweb format or the https://
ipaddress/rdweb format.

2. Type the User Name and Password, and then click OK.

When the user is finished with the session, she should log off and close the Web browser to
ensure the connection is closed.

The client application for Remote Desktop Services is called Remote Desktop Connection,
which is covered next.

Understanding Remote Desktop Connection

Anyone who’s/on the go often needs to access a computer at home or at work. Remote
Desktop Connection allows you to set up a computer for remote access, and then
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Windows 7 Remote Desktop Connection allows you to access another computer on a
network or over the Internet, and use the computer as if you were sitting in front of it.
This feature is handy for people who want to access files on their home computer while at
work, for example. Remote Desktop Services is the technology that allows Remote Desktop
Connection to work.

When setting up Remote Desktop Connection, you must allow remote connections to the
computer you want to access remotely. The remote computer may run any of these operating
systems:

* Windows XP Professional edition
* Windows Vista Business, Ultimate, or Enterprise edition

* Windows 7 Professional, Ultimate, or Enterprise edition

Setting up Remote Desktop Connection can take some effort if the remote computer is out-
side of your network. You might need to configure your firewall to allow Remote Desktop
connections. You must also determine the IP address of the remote computer (such as the
home computer you want to connect to), and configure the remote computer’s router to for-
ward TCP port 3389 to the destination computer’s IP address.

Allowing remote connections between your computer and a remote computer outside
your network presents a security risk. The session can be hijacked by a malicious user.
Whenever possible, be sure both computers use strong encryption, complex passwords,
and strong authentication to minimize the possibility of attack.
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== MORE INFORMATION

To learn how to set up a Remote Desktop connection with a computer outside of your net-
work, visit the Allow Remote Desktop connections from outside your home network Web
page at hetp://windows.microsoft.com/en-US/windows7/allow-remote-desktop-connections-
from-outside-your-home-network.

For more information about how to use Remote Desktop Connection, visit http://windows.microsoft.com/en-US/
windows7/products/features/remote-desktop-connection. You can learn about Remote Desktop Services at http://
windows.microsoft.com/en-US/windows7/What-is-Remote-Desktop-Services

Figure 3-34
The Remote tab
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SET UP REMOTE DESKTOP CONNECTION
GET READY. To set up Remote Desktop Connection, perform the following steps:

1. Click Start, right-click Computer, and then click Properties. The System window
displays.

2. In the left pane, click Remote settings. If you're prompted for an administrator
password or confirmation, type the password or provide confirmation. The System
dialog box displays with the Remote tab displayed (see Figure 3-34).

F ™
System Properties u

| Computer Name | Hardware I Advanced I System Protection | Remate

Femote Assistance

Allow Remaote Assistance connections to this computer

ORIRESALE

Remote Desktop

Click an option, and then specify who can connect, if needed.
@ Dont allow connections to this computer

() Mlow connections from computers running any version of
Remote Desktop (less securs)

i) Allow connections only from computers running Remote
N Desktop with Metwork Level Authentication {more secure)

Lok ][ Gance || Aoply

3. In the Remote Desktop section, select one of the options to allow connections:

* Don't allow connections to this computer: Selecting this option prevents anyone
from connecting to your computer using Remote Desktop or RemoteApp.

e Allow connections from computers running any version of Remote Desktop:
This option allows users running Windows XP, Windows Vista, or Windows 7 to
connect to your computer using Remote Desktop or RemoteApp. If you aren't sure
which operating system is running on the remote computer, use this option.
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Figure 3-35

The Select Users dialog box

¢ Select Allow connections only from computers running Remote Desktop with
Network Level Authentication: This option allows Windows 7 users to connect to
your computer if they’re running Remote Desktop or RemoteApp with Network Level
Authentication. This option offers the most security.

4. Click Select Users.

5. In the Remote Desktop Users dialog box, click Add. The Select Users dialog box
displays (which might be named Select Users or Groups). See Figure 3-35.

"

Select Users m

Select this object type:

Users ar BLliIt-in se«::l.lri’f).r prin-c:ipals

From this location:

WINCEAINTS0EGO

Enter the object names to select (examples):

|| Check MNames

o) [

—— T———
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clicking the Object Types button.
e To specify the search location, click the Locations button.

e In the Enter the object names to select box, type the user name that you want
to search for, and then click Check Names. If the user name isn’t found, click
Advanced to run an advanced search.

7. When you find the user name you want to add, click OK. The name will be displayed
in the list of users in the Remote Desktop Users dialog box.

8. C(lick OK, and then click OK again.

Once the remote computer is set up to accept connections, leave the computer running in
order to connect to it at a later time.

O CONNECT TO A COMPUTER WITH REMOTE DESKTOP CONNECTION

GET READY. To connect to a remote computer, perform the following steps:

1. Click Start and in the Search programs and files search box, type remote connect.
In the results list that displays, select Remote Desktop Connection. The Remote
Desktop Connection window displays (see Figure 3-36).

2. In the Computer field, type the IP address or name of the remote computer if both
computers are on the same private network. If the remote computer is on a different
network, type the router’s public IP address followed by a colon and the port number
(for example, XXX.XXX.XX.XXX:3389). Replace the Xs with your actual public IP address.

3. Log on to the remote computer.
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1 - F ™%
Figure 3-36 & Remote Desktop Connection =l
The Remote Desktop
Connection window | Remote Desktop
Connection
Computer: Example: computer fabrikcam .com -

Username: Mone specified

The computer name field is blank. Enter a full remote computer
name.

.C/ Options [ Connect J[ Help ]

LS &

Once you connect, you can access resources on the remote computer as if you were sitting in
front of it.

== MORE INFORMATION

For more information about Remote Desktop Connection, visit http://windows.microsoft.com/en-US/windows7/
products/features/remote-desktop-connection

Understanding Remote Management and Assistance

When you 're asked to help a friend or co-worker with a computer problem, being able to
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computer) is located remotely. You can even take control of the remote computer if necessary.

Windows Remote Assistance is similar to Remote Desktop Connection, but the purpose of
Remote Assistance is to allow one person to connect to another user’s computer to provide
« » . . . .

hands-on” help. For example, Albert is a traveling salesperson who is having trouble format-
ting a document in Microsoft Word. Maria, a technical support specialist at the main office,
can set up a Remote Assistance connection with Albert’s laptop, and then take control of his
computer and show him how to fix the formatting issues.

Windows Remote Assistance sessions are encrypted for safety. They're also password protected,
so only a person who is invited to the Remote Assistance session can connect to the computer.

To request remote help and initiate a Remote Assistance session, you send an invitation to the per-
son who will be assisting you. That person accepts the invitation and connects to your computer.

4= MORE INFORMATION

For more information about Windows Remote Assistance, visit http://windows.microsoft.com/en-US/windows7/
What-is-Windows-Remote-Assistance

O SET UP A WINDOWS REMOTE ASSISTANCE SESSION

GET READY. To set up a Windows Remote Assistance session, perform the following steps:

1. Click Start and in the Search programs and files search box, type remote assist.
In the results list that displays, select Windows Remote Assistance. The Windows
Remote Assistance window displays.

2. C(Click Invite someone you trust to help you.
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I

f an error message appears stating that your computer is not set up to send invitations,

click Repair. The problem may be related to your firewall, which needs to be disabled

t

emporarily. Start Windows Remote Assistance again after the problem is resolved.

3. In the screen that displays (see Figure 3-37), either create an invitation as a file and
send it via e-mail automatically (if the option is available) or click Save this invita-

tion as a file. If you chose to save the file, the file is named Invitation.msrc. Send it

via e-mail to the support person.

Figure 3-37 i

The Windows Remote
Assistance window

LICENSE

@ sl Windows Remote Assistance

How do you want to invite your trusted helper?

You can create an invitation and send it to your helper. You can also use Easy Connect to simplify
connections to your helper. How do I know which to choose?

= Save this invitation as a file
You can send this invitation as an attachment if you use web-based e-mail.

Use'e-mail to send aninvitation
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= Use Easy Connect
Use this option if Easy Connect is also available to your helper.

o

Figure 3-38

The Windows Remote
Assistance password
dialog box

4. A dialog box displays with a password (see Figure 3-38). Give this password to the
support person over the phone.

r ™
% Windows Remote Assistance Elﬂlg

&P Chat E;I- Settings [ Troubleshoot @ Help

Give your helper the invitation file and password

WLQNCLPIRXSS

@ Waiting for inceming connection...

5. Leave the session open and wait for the support person to connect to your computer.

6. The support person receives the invitation and opens it. A Remote Assistance dialog
box displays, prompting for the password (see Figure 3-39).
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Figure 3-39

The Remote Assistance dialog
box appears on the support
person’s desktop

Figure 3-40

The Windows Remote
Assistance window on the
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- -
Remote Assistance u

Enter the password to connect to the remote
computer

You can get this password from the person requesting
assistance. A Remote Assistance session will start after you
type the password and click OK,

Enter password:

| ok | [.Cancel

7. After typing the password, Windows Remote Assistance attempts to connect to the
client’s computer.

8. The client must click OK in the dialog box that displays, asking if it is OK for the
support person to connect.

9. The Windows Remote Assistance window displays on both the client’s desktop (see
Figure 3-40) and the support person’s desktop.

B Wi Remote Assistance helped by Kim
Inyitation o Stopsharing | Pause | Chat F Settings (@l Help
0 et o e Temporarily hide your screen from your helper. [Alt+P) i ;

1207PM |
9/5/2011

- |me ';J;| i)

Any actions the client performs are displayed to the support person. The support person can
click Request control to take control of the clients desktop through the Windows Remote
Assistance window. For security purposes, a dialog box is displayed on the client’s desktop,
prompting for permission. At any time, either user can click Szop sharing to prevent the
support person from controlling the client’s desktop. While a Remote Assistance session is
live, both the support person and the client can open a chat window to communicate rather

than communicate using a telephone. To end the session, simply close the Windows Remote
Assistance window.
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CERTIFICATION READY

What is an MMC snap-in?

Figure 3-41

The Administrative Tools
window
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TAKE NOTE

Using the MMC

When assisting users with computer problems or maintaining systems, a support person
often needs to check computer events, look at computer resource usage, or examine

a disK’s partition, among other tasks. You may use Microsoft Management Console
(MMC) tools and utilities for this purpose.

Lesson 2 introduced the Microsoft Management Console (MMC), a collection of administra-
tive tools called snap-ins. An MMC snap-in is a utility provided by Microsoft or a third party
that’s accessible through a common interface. Administrators use MMC tools for managing
hardware, software, and network components on a computer.

Administrative Tools is a popular collection of tools that use the MMC. You can access
Administrative Tools by typing admin tools in the Search programs and files search box and
selecting Administrative Tools from the results list. The Administrative Tools window (see
Figure 3-41) lists several tools.

Q'\_) + Control Panel » System and Security » Administrative Tools - | +4 | | Search Administrative Tools 2 |
Organize » Burn =« i @
T * MName Date modified Type
=
Ml Desktop ‘ ‘ é[a Component Services 7/13/200811:57 PM  Shortcut
& Downloads {2 Computer Management 0911:54 PM  Shortcut
4 Dropbox ﬁ Data Sources (ODBC) 11:53 PM.__ Shortcut
5l Recent Places || (5 Event Viewer 11:54PM  Shortcut

=“NMOT-EQRERESALE

| Documents {3 Microsoft .NET Framework 1.1 Wizards 7/28/20010 125 PM Shortcut
o Music {z) Performance Monitor 7/13/200911:53 PM  Shortcut
= Pictures @i Services 7/13/200973:54 PM  Shortcut
B¥ videos [@) System Configuration 7/13/200911:53 PM  Shortcut
@ Task Scheduler 3/200911:54 PM  Shortcut
*d Homegroup ﬁ Windows Firewall with Advanced Security  7/13/2009 11:54 PM  Shortcut
[ Windows Memory Diagnostic 7/13/200811:53 PM  Shortcut
. Computer @ Windows PowerShell Modules /200912:32 AM  Shortcut
&, Local Disk (C)
=a RECOVERY (D:) 5| < mn | [
R 14 items
g 4

To show Administrative Tools in the Start menu, right-click Start, click Properties, and
then click Customize. Scroll down to the System administrative tools heading, select
Display on the All Programs menu, and then click OK.

Computer Management is a popular snap-in that includes several tools such as Disk
Management for configuring hard disks and their partitions and Event Viewer, which allows you
to view computer event information such as program starting and stopping (including program
crashes) and security problems. (See Figure 3-42.) You can manage system performance and
resources using Performance Monitor, which is under Performance > Monitoring Tools.

Some administrators and power users create a custom MMC that includes only the tools they
use regularly, creating a toolkit of sorts.
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Figure 3-42

The Computer Management
window

Q
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Figure 3-43

Selecting snap-ins for a custom
MMC

s Ty
& Computer Management lﬂ‘ﬂg

File Action View Help

& Computer Management (Local) ¥ Actions
*‘ i s:mm i Overview and Summary Last refreshed: 9/6/2011 8:20:16 AM

-
4 (D) Task Scheduler P - P ———

[ Task Scheduler Library = = OpenSaved Log...
4 & Event Viewer To view events that have occurred on your computer, select the appropriate m ¥ Create Custom View...

= source, log or custom view node in the console tree. The Administrative :
1 [F Custom Views onsole )
e T Events custom view contains all the administrative events, regardless of - Import Custom View...
[ Windows Logs

» [ Applcations and Services Lot | Summary of Administative Events &l Miew ’

:a Subscriptions

|5 Refresh
4 @] Shared Folders Event Type EventID  Source Log Last hour 2 H e »
] Shares < an J 3
[ Sessions
@ Open Files

4 () Performance LIS i |
» [ Monitoring Tools

» [59 Data Collector Sets MName Description  Medified Created
¢ [y Reports < mn ] b
% Device Manager

a E Storage I‘% Summag &

2§ Disk Management
4 [y Services and Applications Log Name Size (Curr... Modified Enabled =
L Services

& WMI Control

4 . 3

R I d 3

CREATE A CUSTOM MMC

GET READY. To create a custom MMC, perform the following steps:

1. Click Start, type MMC in the Start menu and in the Search programs and files search
box, type mmc. In the results list that displays, select mmc.exe.

2. In the MMC Console window that displays, click File > Add/Remove Snap-in. The
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Management (see Figure 3-43). In the middle of the dialog box, click the Add button.

Add or Remove Snap-ins n

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Mvailable snap-ins: Selected snap-ins:

Snap-in Vendor = [ console Root Edit Extensions. ..
i . & S ——_— e ————
ActiveX Control Microsoft Cor e
| Aut‘ﬂorizah'on Manager Microsoft Cor

|| | Gl Certificates Microsoft Cor|=
| | % Component Services Microsoft Cor Move Up
5r3 Computer Management [ siegero ey Select snap-ins here T r—
&Devio& Manager Microsoft Corl—l ‘&/
=4 Disk Management Microsoft anc ~~
{2 Event viewer Microsoft Cor Add button
[ Folder Microsoft Cor
.g IP Security Monitor Microsoft Cor
.g IF Security Policy Manag... Microsoft Cor
=] Link to Web Address Microsoft Cor _
e i s Advanced. ..
Description:

Computer management and related system tools.
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In the dialog box that displays, leave Local computer selected (unless the computer
you want to manage is one other than the current computer).

4. Click Finish. The snap-in is added to the Selected snap-ins pane on the right.

5. Repeat Step 3 and Step 4 for each snap-in you want to include in the custom MMC.
Figure 3-44 shows the Console window with a few snap-ins added.

Figure 3-44 [ Consolel - [Console Root] E@Iﬁ\
A custom MMC File Action View Favorites Window Help - |5 %
E==|E =
| Console Root Mame  Actions

> & Computer Management (Local)

i Computer Management (Local) Console Root -
> [ Event Viewer (Local) = ; :

@ Event Viewer (Local) Muore Actions »

Snap-ins added to
this custom MMC
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To avoid exposing a computer to malicious attacks, Microsoft recommends that you use
MMC snap-ins when you are not logged on as Administrator.

Using Windows PowerShell

The MS-DOS command window—accessed by clicking Start and typing cmd in
the Search programs and files search box and selecting cmd.exe in the resulting
list—doesn’t provide all of the commands you might need. For scripting and other
administrative tasks, you must use Windows PowerShell.

CERTIFICATION READY Windows PowerShell is a command-line interface used mainly by IT professionals to run
T T A ThES cmdlets (pronounced command-lets), complete background jobs (processes or programs that
oM naime run in the background without a user interface), and run scripts to perform administrative
interface used mainly by tasks. If you're familiar with the UNIX shell, Windows PowerShell commands should seem
IT professionals to run highly familiar.

scripts?

The Windows PowerShell environment is built on the .NET Framework, which allows
administrators to use many more tools and commands than the MS-DOS command window
environment. PowerShell and the MS-DOS command environment are compatible, however.
For example, you can run Windows command-line programs in Windows PowerShell and also
start Windows programs like Calculator and Notepad at the Windows PowerShell prompt.

Another feature of Windows PowerShell is remoting. Administrators can use cmdlets to access
remote computers or use the Windows PowerShell Remoting service to run commands on
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remote computers or even many remote machines. Windows PowerShell Remoting can
require substantial setup, which is not within the scope of this book.

For more information about Windows PowerShell, visit the Windows PowerShell Getting Started Guide at http:/
msdn.microsoft.com/en-us/library/aa973757%28v=vs.85%29.aspx. Windows PowerShell Remoting commands
can be found at http://msdn.microsoft.com/en-us/library/ee 706585(v=vs.85).aspx

Figure 3-45

Running the ps command in
Windows PowerShell
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TAKE NOTE

RUN A CMDLET IN WINDOWS POWERSHELL

GET READY. To run a cmdlet in Windows PowerShell, perform the following steps:

1. Click Start > All Programs > Accessories, click the Windows PowerShell folder, and
then click Windows PowerShell. (Alternately, click Start, and in the Search programs
and files search box, type powershell. In the results list that displays, select
Windows PowerShell. The Windows PowerShell window displays.

2. A commonly used command is ps (or get-process). The ps command lists the currently
running processes and their details, such as the process ID, process name, and
percentage of processor usage (CPU). Type ps and press Enter. (See Figure 3-45.)

¥ Windows PowerShell

Windouws PowerShell

PSS C:sUsers~Him> ps
NPM<E>

PM<E>

Copyright (C> 2889 Microsoft Corporation. All rights reserved.
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dllhost
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DpHostW
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DUMExportService
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EvtEng
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firefox

hpCas 1Motification
HPDryMntSuc

3. To get help with the ps command, type get-help ps and press Enter.

4. To view running services, type get-service and then press Enter. A list of services
displays, along with their status (Running or Stopped).

You'll learn about managing services in Lesson 4 using the MMC; for now, know that
you can use the PowerShell commands Stop-Service servicename and Start-Service
servicename to accomplish the same tasks.

5. To exit the Window PowerShell window, type exit and then press Enter.
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SKILL SUMMARY

IN THIS LESSON YOU LEARNED:

e Internet Explorer 9 is the latest Web browser from Microsoft. The Internet Explorer 9
interface includes enhanced user features, such as a large Back button, a combined
Address bar and search box, One Box, the New Page tab, and the ability to pin sites to the
Windows 7 taskbar.

¢ Internet Explorer 9 security and privacy features include ActiveX Filtering, SmartScreen
Filter, a Cross-Site Scripting (XSS) Filter, InPrivate Browsing, Tracking Protection, and
domain highlighting.

e Windows 7 native applications include accessory programs such as Calculator, Notepad,
and Paint, plus much more. The Snipping Tool allows you to capture, save, an annotate
screen shots. Windows Media Player is a versatile music and video player, with the ability
to view slide shows of photos, share media across a network, and burn and rip CDs.

e Windows Media Center turns your computer into a digital video recorder, allowing you to
record and play back TV programs, including HDTV. You need a TV tuner and a subscription
to a TV programming service (such as cable).

e Sync Center is a feature in Windows 7 that allows you to sync files between a computer
and a network location, and between a computer and some mobile devices.

e Windows Mobility Center is a control panel of sorts that gives you access to several
laptop settings, from volume to screen brightness to power options to WiFi and Bluetooth
settings—allin one place.

Windows 7 Remote Desktop Connection allows you to access another computer on a
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allows one person to connect to another user’s computer to provide “hands-on"” help.

* You can access Administrative Tools from the Microsoft Management Console (MMC) and
even create your own custom MMCs.

e Windows PowerShell is a command-line utility that enables administrators to perform
many administrative tasks, similar to MS-DOS and UNIX commands.

Knowledge Assessment

Fill in the Blank

Complete the following sentences by writing the correct word or words in the blanks provided.

1. is a feature in Internet Explorer 9 that incorporates search functionality
into the Address bar.

2. A is an Internet Explorer 9 Web site you “attach” to the Windows 7
taskbar.

3. helps prevent personal information and browsing history from being

stored by Internet Explorer 9.

4. The detects threats on Web sites, such as phishing attacks and malware
downloads, and prevents them from running.
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5. is an accessory program that comes with Windows 7 that allows you to
take screen shots, annotate them, and save them.

6. is a feature of Internet Explorer 9 that helps you control which Web
sites can track your online browsing activity and receive that information.

7. After you synchronize files between your computer and a network location, the files you
use on your computer are referred to as

8. allows you to set up a computer for remote access and then connect to
that computer wherever you may be.

9. An MMC is a utility provided by Microsoft or a third party that’s
accessible through a common interface, such as Administrative Tools.

10. is a command-line interface used mainly by IT professionals to run
cmdlets, background jobs, and scripts to perform administrative tasks.

Multiple Choice
Circle the letter that corresponds to the best answer.

1. Which of the following is not a security or privacy feature of Internet Explorer 92
a. InPrivate Browsing
b. Pinned site
c. ActiveX Filtering
d.-Domain highlighting

2. Which of the following can you do with the Snipping Tool?
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c. Add typed callouts
d. Save in PDF format

3. You want to use the Run command, however, the program requires elevated or adminis-
trative privileges. When you right-click the program to run it, which command do you
select from the shortcut menu?

a. Run elevated

b. Run protected

c. Run with permission
d. Run as administrator

4. Which of the following can you do with Windows Media Player 12? (Choose all that apply.)
a. Stream video files over the Internet
b. Rip music from a CD
c. Play aslide show
d. Create playlists

5. Where do you configure security zones in Internet Explorer 9?
a. Internet Options Security tab
b. Internet Options Privacy tab
c. Safety menu
d. Tracking Protection window

6. You want to run the ps cmdlet. Which utility do you use?
a. MS-DOS command window
b. Windows Remote Assistance
c. Windows PowerShell
d. Computer Management
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7. Which of the following are accessible from the Computer Management window? (Choose
all that apply.)
a. Event Viewer
b. Performance Monitor
c. Remote Desktop Connection
d. Disk Management

8. You want to access your home computer from work to get a file you worked on last night.
Which program can you use?
a. Disk Management
b. Remote Desktop Connection
c. Windows Remote Assistance
d. Sync Center

9. Which of the following is an option in Windows Media Center but not in Windows
Media Player?
a. Record TV programming
b. Watch recorded TV
c. Share files over a network
d. Create playlists

10. Where can you find the program to help you use a projector connected to your computer?
a. The All Programs Accessories folder
b. Computer Management console
c. Administrative Tools folder
d. Windows Media Player
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Circle T if the statement is true or F if the statement s false.
T | F 1. You can click and drag a Web site’s thumbnail that appears on-the Internet Explorer 9
New Tab page to the taskbar to pin it.

T F 2. Remote Desktop Connection and Windows Remote Assistance are the same
program used in different ways.

T | F 3. Windows Remote Assistance sessions are encrypted for safety.

T F 4. Remote Desktop comes with all editions of Windows 7; however, you can only
connect to computers running the Professional, Ultimate, or Enterprise editions.

T | F 5. Windows Mobility Center includes access to power plans and screen brightness.

Competency Assessment

Scenario 3-1: Securing Internet Explorer 9

Your co-worker Preena is finalizing a big project for a medical client and has many sensitive
client files on her computer. She asks you to help her make her computer as safe as possible
while accessing the Internet. What do you do?

Scenario 3-2: Offering Remote Assistance

Your sales people travel extensively and often need technical assistance with configuration
settings on their laptops running Windows 7. Which feature or program do you use to
provide remote support for these employees?
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Proficiency Assessment

Scenario 3-3: Pinning Multiple Web Sites

Roberta is a high-tech researcher who uses the Bing search site and the Microsoft Web site
daily. She wants to access the sites quickly whenever she uses Internet Explorer. How do you
advise her on how she can access sites quickly?

Scenario 3-4: Creating a Playlist

You provide technical support to a small dental practice. The office manager, Shanice,
hands you several company-owned music CDs. She wants the music piped to the lobby area
where patients wait to be seen for their appointments. The computer used at the reception-
ist’s desk is running Windows 7 and has wireless speakers that can be set up in the waiting
area. What is one method of providing the requested music without spending additional
money?
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